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This document provides basic instruction on how to create, capture and convert Word Processing 
content to be uploaded into OnPoint’s Course Manager for online delivery to users.  By understanding 
how to prepare your files before uploading them to Course Manager, you can better manage the upload 
process as well as ensure your assets have the look and behavior you desire once they are part of an 
online course. 
 
Course authors can import existing content from Microsoft Word using several different approaches.  This 
is an easy way to reuse text previously prepared in Word.  HTML and standard text files can be imported 
in four different ways: 
 
1.  Copy/Paste Text from Microsoft Word 

 
For really simple text assets (read: no special formatting needs, fonts, bullets or numbering), you may 
copy and paste text directly from Microsoft Word into the Course Manager’s text editor.  To do this, you 
must first: 
 

Create an Asset in Course Manager: 
 

1. Under CONTENT, select Assets from the pull-down menu. 
2. Click the Add Asset Button. 
3. Provide an Asset Name. 

[Note:  The system’s default setting is fine for Asset Type = Text/HTML.] 
4. Change the Asset File Type selection to Create Empty Asset File. 
5. At the Upload File field, supply a name for your text file (should not have spaces, and should end 

with .htm).  
6. Specify a Category (to simplify file location/selection later). 

[Note:  Don’t worry about specifying an Asset Size; it is not needed for Text/HTML documents.] 
7. Click the Save Button. 

The asset record will appear.  Notice that the system has assigned an Asset File name 
automatically. 

6. Click the Refresh Button to confirm entries. 
 

Now copy and paste text: 
 

1. Select the appropriate text from your Word document and perform a block copy (by pressing 
block/right-click/Copy, or by pressing CTRL-C on your keyboard). 

2. Switch back to Course Manager, to the Asset you created (as described above) on the Content: 
Asset screen.  Click the Edit-Text Button (located to the right of the 3rd line -- Asset Type field).  
A text editor will appear. 

3. Click inside the text box, then paste by pressing right-click/Paste, or by pressing CTRL-V on your 
keyboard.  Your text will appear inside the text box.  You may edit as desired. 

4. Click the Save Button.  The Asset record will reappear. 
5. Click the Refresh Button.  Notice that the word “Text” now appears in the Asset Type field. 

The Asset is now active and can be assigned to a Page. 
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Click the Preview Button to review the Asset if you wish.  Click the Close Button when finished 
previewing. 
Click the List Button to return to a list of all Assets. 

 
 
2.  Copy a Document or Table from MS Word by saving it as a Web Page (HTML file) 
 
You may import an entire Word document, a table, or a portion of a document into Course Manager as an 
HTML document generated using MS Word’s “Save as Web Page” function.  [Remember, you will want to 
limit the amount of text that a learner is required to read as one asset inside the Content Viewer.] 
To do this, you must first: 
 

Save the Word document or fragment as an HTML file: 
 

1. Create or select the Word document.  Click on the Save as type drop-down in Word, and choose 
the Web Page (HTML) file format. 

2. Close the document. 
3. Switch to Course Manager. 
 
Now create a new Asset: 
 
1. Under CONTENT, select Assets from the pull-down menu. 
2. Click the Add-Asset Button. 
3. Provide an Asset Name. 

[Note:  The system’s default settings are fine for Asset Type = Text/HTML and Asset File Type 
= Upload Single Asset File.] 

4. At the Upload File line, select the Browse… Button and locate the new HTML file you just 
created.  Double click on the file, and it will be uploaded into the Asset. 

5. Specify a Category (to simplify file location/selection later). 
[Note:  Don’t worry about specifying an Asset Size; this is not needed for Text/HTML documents.]  

6. Click the Save Button. 
The Asset record will appear.  Notice that the Asset File name has been entered as an .htm file. 

7. Click the Refresh Button.  Notice that the word “Text” now displays in the Asset Type field. 
The Asset is now active and can be assigned to a Page. 

 
Click the Preview Button to review the Asset if you wish.  Click the Close Button when finished 
previewing.  
 
You may edit the text by: 
    
1. Select the Edit-Text button on the Asset record (located to the right of the Asset Type field).  The 

text editor program will load. 
2. Click the Load Text button. 
3. Edit the text as desired.  You can also click the “Edit HTML” checkbox to view the HTML codes 

for the text asset and edit in HTML as needed.  [NOTE: If you do edit in this mode, make sure 
you deselect the “Edit HTML” checkbox before you Save, otherwise your asset may not 
work properly]. 

4. Click the Save Button. 
 
Click the List Button to return to a list of all Assets. 

 
Tip:  If you: 

(1) have a highly formatted document, 
(2) may need to edit the text in the future from inside Course Manager, or 
(3) are not versed in html editing, 
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then you may want to eliminate the formatting from the Word document before you import it to Course 
Manager.  To do this, click on the Save as type drop-down in Word, and save the document as a “Plain 
Text” file.  This will strip out all the formatting, leaving just the text to block paste (Option #1 above) or 
import (Option #2 above) into Course Manager.  You can then use Course Manager’s Text Editor to apply 
bullets, colors, font types and sizes, etc., and you will not need to use the html editor to do so. 
 
Tips for Using Course Manager’s internal Text Editor 
 
Funky Characters 
If you experience problems with certain characters such as apostrophes, quotation marks, and double 
dashes, either delete them in the Edit-Text mode, or use (enter) html code to surround them so that they 
can be recognized properly when displayed via the Internet. 
 
Bullets 
If you use the internal Text Editor to block text to assign as a bullet, you will have better results if you do 
this one bullet at a time, rather than blocking the entire page.  And always “scrape” your block action from 
top to bottom. 
 
Edit HTML 
If you click the Edit HTML checkbox, all HTML codes will appear with the text.  If you edit in this mode, 
remember to “uncheck” the box before you Save.    
 
 
3.  Importing a Collection of HTML/Text Documents (Mass Imports) 
 
When dealing with an abundance of existing content, it’s much easier to do a mass import of your files by 
executing the following procedures.   [Note: These same procedures work with all other asset file 
types as well, including images, Flash animations, Impatica files, and audio and video files.  You 
can even mix and match asset types in a zip file during imports.  Currently, you are limited to one 
asset per created page using this import method, but assets added this way are easily reassigned 
to other compound asset pages as required.] 
 
To do this, you must first: 
 

WINZIP all of the files you’d like to upload in mass: 
 

1. Copy all of the files you wish to upload in mass to a common directory or folder.  For simplicity 
later in managing and organizing these files, make sure your files have descriptive names so 
you’ll be able to recognize and order them during the import process.  [NOTE: It may even make 
sense to number each of the files so they will appear in order upon import and won’t 
require re-sequencing later]. 

2. Zip all of the files up into a single ZIP package. 
3. Access Course Manager with your administrator username and password.  [NOTE: Currently, you 

need to be a Content Administrator to use the Import/Export feature]. 
4. Go to the Administration menu and select Import/Export from the pull-down menu.  
5. Click the “Import Course” link to begin importing your prepared zip file. 
6. Step 1 – Select your Zip File to Import.  Click the Browse button to locate and pick your zip file 

from your local or network drive.  After you’ve selected the file, click the Continue button to go to 
the next step of the import wizard.  The file will begin to process.  Depending on how many files 
you’ve included in your zip file, this may take a few seconds to process. 

7. Step 2 – Create Course.  In this step, you can decide whether to import the contents of your zip 
file into an existing course, or create a new course.  If you want to create a new course, replace 
the name of the zip file with the name you’d like to use for the course and you can also assign 
one topic name to your course.  You should also assign a category to your course.  If you choose 
to add these new objects to an existing course, scroll down and punch the appropriate radio 
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button.  [NOTE: If you’ve got your universal filter selected for a given category, only courses 
within that category will appear in the displayed course list; otherwise, you’ll see all of the courses 
on your server].  After you’ve named or selected the course you want to import into, click the 
Continue button to go to step three of the import wizard.  

8. Step 3 – Define Pages.  In this step, you can assign some global defaults to your imported 
assets.  Making careful selections here in Step 3 will simplify the process of organizing and 
readying your new assets for delivery in a course.  

9. First, select a default asset size for all of the assets you’re importing choosing either an 
appropriate “t-shirt” size or custom size as needed.  [NOTE: HTML/Text assets don’t use asset 
sizing].   

10. Next, select a default style sheet from the available choices.  This will be applied to every page 
you create using this wizard.  

11. Next, assign the topic you want your new pages to appear in. [NOTE: This will be defaulted to the 
new Topic Name you supplied in Step 2 if you are creating a new course]. 

12. Next, you can enter a new Page Name for each page.  If the files you are importing were named 
with numerical prefixes, you can strip those out here but the pages will be saved in the proper 
order.  When you’re satisfied with the Topic assignments, Asset Types and Page Names, click 
the Continue button to complete the Import Course wizard.  

13. Now a basic framework for your course exists and is accessible from the Content/Course menu.  
Access your new course by going to the Content menu and selecting Courses from the pull-
down menu. Find your new (or existing) course in its assigned category and access it by clicking 
on the name link. 

14. Once you’ve accessed the course, you’ll need to add a Welcome Message and Finish Message 
and mark the course “Published” in order for it to appear in the course catalog.  

15. You’ll also need to assign users or groups from the Assign User/Groups function at the bottom 
of the Content: Course screen. 

 
 
4.  Third Party Word Conversion Tools for Complex Documents 
 
You can import the contents of a highly-formatted Word document (or portion thereof) into Course 
Manager as a multi-file asset (“MFA”) by first converting your document to a more standards compliant 
HTML format using an inexpensive third party conversion tool like Click to Convert v5.5 from Inzone 
Software.  This US$79 utility package, available via a complimentary 15-day free trial version from the 
Inzone’s web site (www.clicktoconvert.com), produces far superior results vs. Microsoft’s own “Save as 
Web Page” functionality and provides a broad range of features that make it easy to create embedded 
navigation controls and links in your generated outputs.   
 
Once you’ve downloaded and installed a copy of Click to Convert on your Windows PC, follow these 
instructions to convert the sections of your Word document into online courseware/content: 
 

Prepare the Word document or fragment as a Word document file for the text section you wish to 
present: 

 
1. Create or select the Word document.  We suggest using Tahoma or Verdana fonts for web-

presented content as they are easier to read in a web browser. 
2. Click the Click to Convert icon  or select the “Click to Convert” menu option at the top of your 

Word toolbar to start Click to Convert.  
3. When launched, the Click to Convert application will appear as a pop-up utility and provides 

several configuration settings to assist you in preparing and formatting your new content.  You 
can use Click to Convert to generate your content in HTML or PDF format (or both).  Most 
authors will need to de-select the “Create PDF” checkbox and just output an HTML version of 
their content (see Figure 1 below).  It’s a good idea to also select the “Open the HTML file” 
checkbox as well to review your output as soon as it’s been generated so you can check it for 
form and format. 
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Figure 1 
 

4. Next, select the “HTML” options section of the “Customize Options” as shown in Figure 2 below to 
update your standard configuration settings as shown.  Enter your home link and supply an 
appropriate file name you’ll use to launch your asset (e.g., index.html) in the Output menu.   

 

 
 

Figure 2 
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5. Next, switch to the “Table of Contents” page under “HTML options” and either activate or deselect 
the TOC feature to best suit your output needs.  For longer documents, including a TOC frame is 
a good idea (as shown in Figure 3).  For shorter documents, deselect the TOC options.    

 

 
 

Figure 3 
 
6. Once you’ve selected all your options, click on the “Create” button and your HTML files will be 

produced.  You should also be able to preview them in a browser window if you checked that 
option as stated in Step #3 above. 

7. Next, package up all of the generated files into a ZIP package using WinZip and you’re now ready 
to add the new content to Course Manager as a URL multi-file asset.  Set the asset size to 
something fairly large like 800x600 for a text page and 950x600 if you used the TOC option. 

 
5.  Export Word File as PDF File and Display Using the PDF Asset Type 

 
One of the most popular and industry standard file formats for packaging and delivering information over 
the web is exporting content saved in Adobe’s Portable Document Format or “PDF” file format.   The 
format has become so ubiquitous, in fact, that every major computer operating system vendor, including 
Microsoft, includes a free Adobe Acrobat Reader© application or browser plug-in bundled in as part of 
their standard customer offering.  The benefits of creating and distributing PDF files stem from the fact 
that almost any applications can generate native-looking print quality materials, complete with all their 
intended formatting and visual elements, and have these files read online without needing the original 
application to display them properly.  In short, Adobe PDF files are digital “printouts” of any commonly 
generated computer output that can electronically emailed or downloaded as opposed to being physically 
mailed, copied or faxed.   Standard software enables business professionals to convert any Microsoft 
Office and other paper or electronic document to reliable Adobe Portable Document (PDF) files, and send 
them to colleagues for review. 
 
Acrobat 6.0© from Adobe Systems Incorporated, with a street price of around US$300, enables business 
professionals to convert any Microsoft Office and other paper or electronic document to reliable Adobe 
Portable Document (PDF) files, and send them to colleagues for review.  For standard document files 
created using Microsoft Word, content authors can use Acrobat to print out electronic handouts of all or 
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portions of a Word document to be viewed in a web browser as content within an online course or as a 
means of distributing other supporting documentation for that course that can be downloaded and printed.  
Alternatively, other third party applications (like Click to Convert v5.5 covered in the Section 4 above) 
can also be used to convert documents to PDF's, cost much less (e.g., US$79) and produce Acrobat 
Reader compatible content. 
 
The advantages of outputting Word documents as PDF files are obvious.   First, the process is very quick 
and requires almost no decisions to be made given it’s the equivalent of outputting the necessary content 
to a network printer.  Second, the content can be displayed in a browser window as part of a course but 
also can be expanded to view at full screen, viewed as a series of thumbnail images for each included 
page, printed out and even stored locally serving as hard copy documentation for those who require that.  
Thirdly, the content can not be tampered with or changed in any way once it has been published as a 
PDF file.  Finally, for OnPoint customers, this method is probably the fastest way to produce good 
looking content from highly formatted existing materials with the least amount of effort.    
 
There are a few disadvantages of outputting Word documents in PDF format including the fact that the 
more pages you wish to include in your PDF output file, the larger the resulting PDF Asset is going to 
become, and the harder it is to load and navigate around when viewed via a web browser.  It makes 
sense to create short PDF output files with one to four pages each (think “chicklets”) instead of one large 
document with 30 or more pages (a chunk or boulder).  Also, using the chicklet method allows you to 
intersperse topic-level quizzes or tests and intermix rich media pages within the same course thus adding 
to the overall online experience. 
 
Exporting Your Microsoft Word Document as a PDF File  
 

Step #1 – Printing to PDF from Inside Microsoft Word 
 
1. Open the Word document you wish to take online in PDF format. 
2. Once your document has been displayed, select the pages or paragraphs you’d like to output as 

a “PDF Chicklet” and select “Print” from the “File” menu in PowerPoint; you will then be presented 
with PowerPoint’s standard Print Dialog Box.  It may make sense to copy/paste these pages to 
another empty document before generating your PDF file. 

3. FOR ADOBE ACROBAT - Open the Printer “Name” dropdown box and select “Adobe Distiller” 
from the presented choice list (Note:  You must have a copy of Adobe Acrobat installed in your 
computer for this to appear). 

a. Most of the default settings in the “Adobe Distiller” print driver are fine but you can fine-
tune your output by clicking the Properties button.  Typical fine-tuning would include: 

i. Under the Layout tab, select “Portrait” orientation to make sure your output appears as 
standard pages in the PDF file.   

b. Select the “Print Range” you’d like to output and click the OK button to begin the output 
process.  Your computer will now generate the PDF containing static image copies of all 
of the slides you selected for inclusion in your PDF chicklet. 

 
Note:   If you make sure all of the Properties fields found under the File menu have been filled 

out for your Word document before you output your PDF file, this information will be 
included in the Document Summary that accompanies the generated PDF file.  This may 
be important for reasons of copyright and support later for those users who download, 
save and printout PDF assets while talking an online course.   

 
c. FOR CLICK TO CONVERT – Click the Click to Convert icon on your Word Tool bar and 

follow the instructions as outlined in Section 4 above but this time select the PDF options 
and disable the HTML configuration options.    

 
Step #2 – Upload PDF File to Course Manager as PDF Asset 

 
1. Login to Course Manager as a Course Coordinator, Content Administrator or Site Administrator. 
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2. Under CONTENT, select Assets from the pull-down menu (and set a Filter if desired). 
3. Click the Add-Asset Button. 
4. Provide an Asset Name and Description. 
5. Select Asset Name = “PDF” from the dropdown menu. 
6. Select the “Single File Asset” Asset File Type. 
7. Browse for and select for the PDF file you wish to upload. 
8. Specify the Category and Asset Size for your new PDF asset.  You can pick from any of the “t-

shirt” sizes or specify your own custom asset size.   
 

NOTE:  PDF Assets of text documents should tend to be larger in size but you may wish to play 
around with the formatting to get the best window size to accommodate the page orientation of a 
Word document.  A custom size of 750x450 may prove best.  Remember, all PDF Assets can 
also be opened full-screen in the Content Viewer with the “Open in New Window” link that 
automatically gets inserted onto every OnPoint Page that contains a PDF asset. 

 
9. Click the Save Button.   
10. The asset record will appear.  Notice that the system has assigned an Asset File name 

automatically.  Click Preview to view the new PDF Asset in a window and check its size. 
11. Assign the new Asset to a Page, Topic and Course as needed. 

 


